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A letter direct from the editor desk highlighting on October’17 edition 

Our Magazine, SketchUp-Ur-Space is aimed to deliver the latest news, tips and many more about SketchUp for 
its readers and our October Edition has already published. It is again come with some trendy news for our 
eagerly waiting readers. SketchUp-Ur-Space is a well known and lovable magazine that has useful news and 
data for the beginner and experienced SketchUp users, designers, architects etc. 

Our magazine’s editorial team continuously is trying to deliver new and interesting stories, news, blogs and 
many more other things to enhance the knowledge and skills of the readers. This time also the magazine has 
come up with its various unknown surprising facts on 3D designing. 

At first, the cover story of the magazine describes the process of creating the LayOut and using it in the model 
that will give a smooth flood of designing. 

Second is the article section, here are four new stories again that are written by the editorial team of SketchUp-
Ur-Space magazine on the various way of designing the model by using various plugins and developing them. 
First one is about the “SketchUp Plugins for Structure TrussFab Made of Plastic, Second one is the process of 
making “Hole in a SketchUp Model”. Third one describes about the “Architectural Design with SketchUp” and 
the last one is again a process for using SketchUp for “Developing an Amazing Game Environment”. 

In the Blog there are four posts that are needful in discovering new sides of SketchUp. The first one is about the 
new Tool V-Ray helps in rendering with Accuracy, Second describes the problem on fixing the Clipping issue in 
SketchUp and its way to solve. Third one is about different templates in SketchUp and the last one is process of 
communicating clearly on SketchUp with the clients. 

We all need some tips and tricks to manage and work in a better way and SketchUp-Ur-Space’s Tips and Tricks 
section has come up with that kind of things. First post has given an idea of selecting any part of model clearly 
and in a better way. In the second one SketchUp has find an easy way for printing the models in the 3D Printer 
form 3D Warehouse directly. Third one gives some essential tips to manage Spreadsheet in LayOut and last 
one gives some tips in unwrapping and unfolding the designs in SketchUp. 

The most important news section has focused on some serious issues this time designing and configuring 
processes in SketchUp. There are four news in the News Section, each and everyone has describes the work 
process on a model with more easy and effective way. SketchUp team in Brazil has started an inspiring project 
for the urban area people there to make the future of the kids and younger strong and beautiful. 

So it seems that this edition has published very effective sides of SketchUp and gives some new and interesting 
news also. Hope readers will enjoy this edition and discover some new side of 3D design. 

If you have any queries concerning publication, subscription, troubles navigating the site, 
please mail us at subhra@jobs2india.com 

 

Best wishes  
Subhra Bera 

Editor 
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Interview with Mauritz Snyman who is a specialist in 3D architectural 
modeling, 3D renderings, 3D visualization and 3D animations 

Interviewer: Simul Chowdhury (Editor) 

Introduce yourself to our readers. 

Hi all. Thank you for the opportunity Simul. I'm Mauritz Snyman & the owner of Jireh3D, a company I started in 2008 
focusing on 3D Architectural Modeling & Rendering. I'm based in South-Africa. 

I love what I do. Only a couple of things get me away from my computer - one being fishing. 

 

How did you start your career as a 3D modeler? 

I studied Interior Design but never pursued that. Not long after, I moved to the UK and started out as a CAD technician in 
London. But did not find it creative enough, so I started online 3D modeling training after hours. My boss at the time created 
a position for me but unfortunately during the 2008 recession more than half the company were made redundant. And so my 
own company, Jireh3D was born. 

What kind of hardware do you use? 

At the moment - Apple Mac 8 core, 2.1 Ghz, 64 GIG ram & 2 x 24'' Screens to make life easier. 

Then some other machines which are a lot smaller, but just a backup for rendering 

Can you tell us about the software you use in the studio? 

Sure. I use Sketch-up for all the basic modeling, then Cinema4D to add detail & rendering in VRay or Corona. Adobe 
Photoshop for the finishing touches. 
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Can you define the balance between Pure Render and Post Production in your work? 

Post production is great, but i like getting renders in such a state that there is little Photoshop work involved in the end. It 
depends on the artist really. 

I always use Photoshop to do final touches, but never to create the full image itself because clients change their minds very 
quickly & not many people wants to re-do everything again. 

 

Can you tell us something about your firm? 

My firm is running for about 9 years now. Jireh3D specializes in 3D architectural modelling, 3D renderings, 3D visualisation 
and 3D animations. We bring 2D plans to life in beautiful photo-realistic, 3D images. We create 3D models from CAD plans, 
sketches or simply ideas, supplied by the client. We are able to produce interior and exterior views of the proposed 
development. We can also create fly-through animations. 

Tell us about your work with 3D architectural modeling. 

For us, the modeling part is very important. If the modeling is bad, the renders will be bad. So adding detail is of great 
importance, as that is what helps create realism. 

After modeling, texturing is just as important. 
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Sketch-up is great for modeling things very fast, and if the client changes his design, it can be changed very quickly unlike 
most programs. 

Did you face any problems or technical issues along the project, and how did you solve them? 

50% of the time we run into problems during projects. Most of the time it's a machine that can crash because the scene is so 
poly heavy...Solving that was to upgrade memory & to use a render farm as our backup. 

Another problem is getting paid. What i have learned over the years, is to work with a contract & 50% upfront payment. I lost 
a lot of money because clients ran away, so very important to get a contract & proper payment terms in place. 

 

What was the most challenging project you’ve worked for, so far? 

The one I'm working on currently. Very big & difficult to work with because the model is so poly-heavy. It's for a few exterior 
renders, but the surroundings has tons of foliage which makes the process very slow and quite frustrating. 

What’s the hardest thing about being a professional 3D designer? 

Not getting paid enough for hard work and long hours. It's our bread and butter & lots of people take artists for granted. 

Where is architectural visualization heading next? 

Not sure, but because of the incredible technology, we are going forward really fast and it is difficult to keep up to date to the 
latest programs & plugins in the industry. 

What suggestions do you want to provide for newbie 3D modelers? 

If you want to do this full time, make sure you do it in excellence. Always give your best and be teachable so there will 
always be room for improvement. 

How do you evaluate our magazine? 

Very good. Lots of 3D Artists can learn from this & tons of info are available for anyone with many tips & tricks. 
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www.behance.net/Jireh3D 
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How to Create and Use SketchUp LayOut 

Simul Chowdhury: Editor 

Working with SketchUp LayOut allows you to maintain a smooth flow of designing. The options and features 
creatively carve out your designing instinct. When you open SketchUp LayOut, two dialog boxes will generally 
appear – Tip of the Day and Getting Started. 

Getting Started Dialog box contains different templates of your LayOut document, and it comes up with options 
required for adding features and functions easily to your design. There is a template always on which a Layout 
is based. Storyboards and title blocks are also there in LayOut. Other than this, you can also prepare a layout 
adding your preferences. 

SketchUp lets you customize every detail in template so that you can enjoy a spontaneous designing. After 
choosing a template, you can modify features like paper size, margins, and units. Once you modify every 
necessary detail in the template, you save it giving a particular name of your file. 

Choosing a template: For every new LayOut document, you need to select a template from the Getting Started 
dialog box. There are options like graph paper, plain paper and story board that assist in you choosing the right 
one. You can also change the template later while designing from the template setting box. The list below 
mentions details of the content. 

Select a default template: there are three categories carrying templates with different measurement and looks. 
Under the ‘New’ tab in the Getting Started dialog box, you will get options: 

• Paper: common paper sized templates are listed in the category. You can easily get letter landscape or A4 
size as per your requirement. Papers have portrait or landscape orientations and they have also come up with 
grid paper and plain paper options. 
• Storyboard: if you are designing for a storyboard, you can get three preset boxes for defining the functions like 
angles, features and views of a 3D model. 
• Titleblock: there are several titleblock types to choose from. Common style includes modern, rounded, simple 
and traditional forms. 

Select your own template: My Template option helps you work on your preferred template option. The template 
that you create is the foundation of your LayOut project. 

Open an existing document: this feature brings many advantages for your designing purpose. You can easily 
open an existing document in LayOut. 

Paper Setting: Modification is a common step after creating your LayOut. The Document Setup dialog box 
contains the needed options allowing you to make new changes as per your designing concept. 

Paper Setting: In the document setting dialog box, you find options that help you change the document area 
you are working on. The most common paper setting is done by modifying an area’s size, orientation, margins, 
colors, and rendering quality. Below is an introduction of the features in a paper setting dialog box. 

• To customize the setting, you can insert the value of width and height of the paper. There are two options 
available for the shape – landscape and portrait. The color swatch option will take you to the color picker where 
you can choose color that is required for your document. For getting color printouts or PDFs of your design, you 
must select the Print Paper Color Checkbox. 

• To change margins of your document, you need to select the margin check box. By default, margins are not 
visible in the document. Input the values for left, right, top and button margins. 

• You can also opt for the high rendering resolution with choosing high, low or medium resolution quality for 
your design. Both input and output resolution can be adjusted in SketchUp. 

 

mailto:simul@jobs2india.com�


 

8 | P a g e  
 

 

Unit Setting: Unit setting helps you in measuring the design in your preferred unit. To modify the units of your 
design, you need to click File and choose the Document Setup option. Select Units for changing the 
measurement. 

Save LayOut Document: Save LayOut document before you add loaded works to it. The LayOut saving follows 
steps the same as you do to save other files (File > Save or File>Save As). 

The content offers you an insight of the LayOut option in SketchUp. You can create any documents using the 
above-mentioned steps. You must visit help.sketchup.com for more information. 

  

https://help.sketchup.com/pl/article/3000194�
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SketchUp Plugins for Structure TrussFab Made of Plastic 

Simul Chowdhury: Editor 

Till date, different experiments and innovations have been made with SketchUp. But this one is indeed the 
creative one that opens up another perspective of the 3D modeling software. SketchUp has already been 
proven as an effective tool for designing real objects and its applications go far beyond your imagination. 
SketchUp has been used as the primary tool of designing TrussFab structure, which is new in concepts and 
ingenious in appeal. 

TrussFab is the system of fabricating a large structure that is strong and tough enough to withstand the human 
weight. The process has designed a large-sale structure made of plastic bottles where bottles are used as 
beams instead of bricks. Node-links are used to keep this fabrication settled always, even in loads or pressure. 
The best thing is that it does not require sound knowledge in engineering and designing. 

Phd researcher Robert Kovacs has recently created a large-structured trussFab using the plastic bottles. His 
team from Human Computer Interaction Lab from Hasso Plattner Institute in Potsdam, Germany has given a 
complete support to achieve this high. They made an end-to-end large-scale structure which is sturdy enough 
to stay unaffected. 

The use of plastic bottles and 3D printing joints make the things even easier to construct for the team. 

TrussFab uses plastic bottles to make rectangular trusses that are called the building blocks for designing a 
large scale TrussFab. SketchUp is offering TrussFab plugins that allow users to design the structure digitally 
prior to the construction. This plug-in also converts an existing structure into TrussFab one smartly without your 
intervention. 

TrussFab SketchUp Editors has primitives that are used as building blocks for designing the model digitally. 
Generally, tetrahedron and octahedron shapes are available for designing trusses. Once the model is complete, 
the plug-in generates 3D model file for each node, which can be sent to the 3D printing. 

With this SketchUp plugin, 3D printer and necessary materials, anyone can try their hands at designing 
TrussFab. This fabrication of large-scale structure made of waste materials gains popularity across the world. 
Designers also exhibit their creativity by making different models using the rule of TrussFab. 

TrussFab presents an amazing application of SketchUp. Before this, the 3D modeling application has been 
famous for many creative projects like designing a playground with waste materials. The playground has 
become a successful venture in distant areas in the world and it earned appreciation from government and non-
government organizations. 
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TrussFab is also gaining publicity as the nascent designers come up with plans to design big structure. 
SketchUp is the core platform where designers can test their skills virtually. 

Article Source: www.archdaily.com  

http://www.archdaily.com/873828/this-sketchup-plugin-can-design-structures-made-from-plastic-bottles-and-3d-printed-joints�
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How to Make a Hole in a SketchUp Model 

Simul Chowdhury: Editor 

SketchUp seems to be the easiest platform in 3D designing with easy-to-learn tools and features. Still, users 
sometimes stumble with issues in their designing. Putting a hole in SketchUp model remains in the query list of 
designers always. Though many SketchUp forums discuss the topic with a great interest, designers feel blank 
why they fail to draw holes in their models. The content brings out some interesting ways with which one can 
simply solve the problems. The ways mentioned here are suggested by users themselves as no one can 
understand your problem better than them. Information singularly presented how to put a hole in a SketchUp 
model. 

Tips required drawing a hole in SketchUp model: 

• Push/pull tool is designed to perform the work we are talking about. You have to know how to use the tool to 
drill a hole into a model. To draw a hole in your design, you must select a shape of the hole and choose 
push/pull tool. Push the shape area until the pop-up menu shows On Face. If the hole is not enough deep, the 
model does not create the feature in question. 

The picture above shows that it pushes the shape to the face of the design. 

• You need to have a perfect square wall for this feature. If you do not have the same, the application will not 
work. 
• The circle that you want to make a hole in must be attached with the model. You can simply follow the steps: 
Draw surface > Draw a circle on surface > delete circle inside > Push Pull the rest of the surface. One thing you 
must ensure that the circle must be attached to the surface. Otherwise, the push/pull function will not work. To 
create a hole in a solid model, you need to draw a circle > ensure the circle is attached to the surface > push 
pull to the back of the face. 

To check the circle whether it is attached or not, you need to move the circle after it is drawn. If other 
geometries move along with the circle, then it is attached to the surface. 

For video tutorial: 

https://youtu.be/Hb-Adao_Q1c 

Drilling a hole correctly is not a completed thing of SketchUp. If your design follows the right measurements, 
you should not have to be worried about using any functions SketchUp is offering to you. The above-mentioned 
information is described for those who face the similar problems. 

 

Article Source: reddit.com 

mailto:simul@jobs2india.com�
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Architectural Design with SketchUp 

Subhra Bera: Editor 

Alex Schreyer, the author of the book “Architectural Design with SketchUp” has introduced it talked many things 
about it at SketchUp’s 3D Basecamp and he had authored some new SktechUp extensions. He also published 
a second edition of the book to shaping SketchUp in a new way. Updated editions from beginning to till last one 
can be found in the SketchUp’s site: SketchUpfor Design.com and this article is simply a review of the book. 

About the book: As like SketchUp team, this book is also has the same motto: It’s for everyone. It is very useful 
for architectural design and also has aimed for all kind of designers. There are various topics in the book such 
as; applying and shaping textures, mastering components, extensions, rendering etc. all are very useful for 
everyone. 

This book don’t have the aim to teach form the beginning but it has very important information for the SketchUp 
users. There is a chapter named ‘SketchUp Refresher’ for the beginners. The book has aimed for exploring 
principles of SketchUp which are not yet covered by any other books and have lots of experienced SketchUp 
modelers. The website ‘SketchUpforDesign.com’ is associated with the book and here people can get much 
resource for SketchUp tips, news and insight. 

The book has divided into five main sections, they are, component-based modeling, extensions, rendering, 
making and Ruby scripting. Here are some details about the sections: 

1. Component-based modeling: This section is a great part which consists the information of using various 
groups and components for building clusters of objects and pervades models with information. As per the 
author, he has a thought to model every element of a difficult construction like floor detail should be designed in 
the software before actually building it. In the digital model there is a chance to correct the mistakes and change 
some things for making it even better than before. 

Though it is not a new technique for the SketchUp’s users but Alex gave it a new look by applying the concrete 
guidance to model the design in a better way with detailed information and objects. This modeling is technically 
very easy one but important as it explores the main things in the book briefly. This section also gives an idea 
about the broader category about information modeling. We all know that BIM can be used as per the need of 
the design but this section casts the idea at the most basic level and the book has the instructions of doing the 
work, utilizing it and also organizing the items. There is also information about dynamic attributes, organizing 
things with industry schemes and generating departs from the model. 

2. Utilizing extensions: There are lots of extensions in SketchUp and identifying the extensions and their work is 
not an easy job. This book has a good collection of information about assembling the models in the alphabetical 
order with a brief description about them. There are also step-by-step tutorials suitable for workflows which can 
work between extensions. 

3. Photo-realistic rendering: Renders don’t have many choices and it is a complicated thing, not a simple thing 
like clicking button and waiting for few hours. There are lot of things than this like the settings, presets, lighting 
environments and many other appliances which can go with making a halfway decent rendering and it need an 
improper amount of background knowledge, as it’s the mixture of science and craft both. 

4. Making: The second edition has come with a new chapter called ‘Making Things with SketchUp’ which 
proves that the book is more than only the architectural field. In this section, some famous digital fabrication 
techniques like 3D printing, CNC, laser cutting and 2D printing etc. has surveyed by Alex and all of these has 
guided with a book for modeling advice, file prep, export considerations and pre-fabrication advice in working 
with other kind of programs. This long section has concluded with many pages and tutorial videos. 

5. Scripting: This section looks little weird for the readers and users as reading and writing simple codes is a 
very simple thing and don’t need any special attention. But Alex has kept this section with the title of ‘Ruby for 
Designers’ here Alex has focused on the use of scripts for achieving forms which can become exhausting for 
the models in SketchUp. Using Ruby for writing codes is to increase the using power of algorithms in making 
stuff when there is no other way and Alex describes it with a tutorial step-by-step process with brief description. 

mailto:subhra@jobs2india.com�
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Lastly it is an approach to the SketchUp lovers to go through this book without any confusion as it will enhance 
the SketchUp using skills as it the processes are clearly-written, briefly described and completed. In the website 
there are sample files, about 30 tutorial videos and a direct way to communicate with author. 

Article Source: blog.sketchup.co 

https://blog.sketchup.com/sketchupdate/new-book-architectural-design-sketchup�
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How to Use SketchUp for Developing an Amazing Game environment 

Simul Chowdhury: Editor 

Till date, SketchUp has made a remarkable name as a simple and easy 3D designing tool. As the time goes, 
the software application pushes its boundary. Designers start using the 3D tool in fields other than known ones. 
SketchUp as a game environment developer is an added application that evolves gradually in the gaming 
industry. Professional developers love SketchUp as it offers a trouble-free way of designing complex models. 
The use of SketchUp in the gaming industry has already been started by Studio Olemingus – an independent 
game studio introduced by Dhruv, a designer and SketchUp artist, and Kevin, a programmer. 

Get started with SketchUp 

Dhruv, the small town boy from Chala in Gujarat, is the man behind this innovative thought of using SketchUp 
as a game developer. He learned SketchUp in 2009-10 as a part of his course. He goes deeper to know how to 
use the 3D tool in an innovative way like no other does. He used the tool for outlining a gallery for the first time 
and came to know that the file size generated by the application is less than the other software. The designing 
is rather simple to understand and to craft. The software application has become an inevitable part of his 
designing since then. 

From outlining just a gallery to developing gaming environments, the journey was a learning one that sharpens 
his skills and makes him comfortable with the features and plugins. For Studio Olemingus, SketchUp is the 
main crafting tool that completes the base of the gaming environment flawlessly. The work, though, follows a 
few steps – developing meshes in SketchUp, painting them with textures designed in Photoshop, and finally 
compiling them in Unity. 

The game ‘Somewhere’: 

Somewhere – the game explores the mythical stories of India that enrich the country’s culture. It is an effort to 
bring back those strange folklores that faded away from the time. The stories are beautifully represented 
through Kayamgadh – the story teller of the game. The narrative-based game is new in its genre and brings a 
different perspective from the conventional ones. The game is an escape to the forgotten stories that revealed 
the India decades back. 

The modeling tools that have been used for developing a gaming environment: 

Scaling: Resize plays a very important role in this field, and scaling tool helps designers to modify the size that 
fits in the environment. Studio Olemingus has used its creativity and resized small objects to bring a new shape 
in its design. In this way, they turn tooth brush into trees and teacups into boulders in a landscape. 

Repetition: Repetition modeling tool helps you create homogeneity in your design. The parts that do not need to 
identify as a single object can use repetition tool. Repetition tool is excessively used in developing a forest 
environment and a wall structure where homogeneity prevails. 

Color and Textures: Though Studio Olemingus has used Unity for color and texture, it creatively used texture 
mapping with SketchUp Paint Bucket tool for prototyping objects with different colors and textures. 

Follow Me Tool: Follow Me Tool works as a loft tool to develop a surface that stretches across the edge. The 
Studio uses this tool in two different ways – radial symmetry and symmetry across the loft axis. 

Terrains: Generally, line, polygon, scale and move tools have been used t carve out the terrains in the design. 
Designing these is easier in SketchUp and takes less time than the other applications. 

mailto:simul@jobs2india.com�
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SketchUp Extensions: Studio Olemingus use ThomThom’s QuadFace Tools to modify the geometry with adding 
subdivisions and unsmooth faces. CLF Shape Bender by Chris Fullmer helped the team create leaves by cut 
out surfaces. Tree maker has been used for creating small plants and leaf components. 

Studio Olemingus explores SketchUp in a new way like no other did before. The tools and features of the 3D 
modeling software application have the potential to design a complete gaming environment in an easy way. 

To read more about the Studio and the game, visit blog.sketchup.com 
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V-Ray 3 for SketchUp – Render with Accuracy 
Simul Chowdhury: Editor 

In the 3D modeling world, Rendering makes your design live and vibrant. It brings in the needed visual that you 
expected to have in your design. With the introduction of V-Ray 3, renders have found a way to easily convert 
their 3D model into the photo real images. The definition says that V-Ray 3 is a rendering extension in an 
advanced level that uses simulated photon wizardry to produce the photo-real 2D images. 

SketchUp has popularly been known for offering the simplest solutions to the complex designing issues. Today, 
designers and artists use this software application widely because it offers really comprehensible functions that 
engaged solely for the designing purpose. V-Ray 3 is such an advanced extension that allows renders to make 
their design cutting-edge and stunning. The flawless depiction of your design is possible for the simplified user-
interface offered by V-Ray 3 extension. There are more things to consider as it comes with a promise to give 
you a never-felt-before experience in the rendering process. 

With an array of functions and features, it indeed gives you a new world of rendering. The content discusses 
further the benefits of using this application. 

• Easy to use – this application, like other applications of SketchUp, is easy to learn. 
• Quality – It offers you the highest quality renders. 
• Power – as claimed by the application, it can render everything, even the most complex 3D models instantly. 
• Speed – Speed is definitely faster than any previous extensions available. It allows you to spend quality time 
in designing. 
• Creative Control – it concentrates on every detail of your design with different creative tools used for lighting 
and rendering. 

It cuts down times that you suppose to give to other than your design. This makes your designing accurate and 
precision. Some factors need to be discussed without which the content remains incomplete. 

Quick Start: 

Clean and simple user interface comforts renders and designers so that they can use their creativity in the best 
way. The quick presets and streamlined controls enhance the workability and they are also helpful to bring out 
your creative skills. The features that may steal your attention away are described below: 

• New UI – easiest user interface to boost the faster workflow. 
• Material Library – it comes up with the 500 drag and drop materials to enhance your speed. 
• V-Ray Swarm – scalable rendering system for a faster rendering. 
• Denoiser – it eliminates the noise and makes the rendering time faster. 
• VR – VR ready 3D model that allows users to witness the in-depth of your design. 
• Aerial perspective – It understands the atmospheric detail of your design 
• Grass – It gives your design a realistic perspective with real grass, fabrics and carpet. 

The functions and features of V-Ray 3 are organized and simplistic. They look after every angle of your 3D 
model and come up with a proper way to solve the complex puzzle of your design. Whether it is adding physical 
materials or maintaining the accurate lighting, it offers the desired solutions. The realistic details are advanced 
to add a feel of a real world experience to your model. V-Ray 3 SketchUp changes the world of rendering 
completely. 

mailto:simul@jobs2india.com�


 

17 | P a g e  
 

 

Article Source: www.chaosgroup.com 

  

https://www.chaosgroup.com/vray/sketchup�


 

18 | P a g e  
 

Clipping and missing faces in SketchU 

Subhra Bera: Editor 

Both SketchUp Make and SketchUp Pro are struggling in fix an issue in SketchUp called Clipping and missing 
faces in SketchUp tool. While revolving around the model, the effects can be seen like a section simply 
attached with the view at a fixed distance and sometime objects can also appear or disappear in a shaking 
mode while zooming in the model. 

The geometry of the model shakes and glitters while revolving the model and it splinters and extra sections 
appear while operating the model. This situation is called Camera Clipping Plane which does not make any 
damage to the model. 

These kinds of problems naturally appear when geometry sometime has been placed very far from the model 
origin that means the imported formation was copied form survey or GIS data. There are many models which 
are hundreds and even thousands of miles far from origin and SketchUp’s display technology was established 
more for distances like in Feet or Meters. Here are some situation described that show the situations where the 
kind of problems found: 

1. When the field of view has been set up widely, the FOV or the field of view can be adjust between 1 to 120 
degrees and it will easily change the FOV by pressing the Shift key to zoom in or out. This can be changed by 
going to Camera > Field of View and by typing the desired field of view in the measurement toolbar. 

2. Secondly it can be happened the angled camera mode is turned off, to change the mode click on the Zoom 
Extents button. After that the camera will zooms out to show the total model and the clipping will be removed. 

3. Another situation is that when the scale of any model is very small or very large. To prevent the problem just 
change the scale while working. 

• When the model stays far away from the origin point where the red, green and blue axes interest, then the 
model can be moved to the origin point and this follows some steps: 

1) select all the geometry of the model by typing Control+A or Command+A or only by simply clicking and 
dragging the Select tool beyond the geometry. 

2) The move tool can be changed from Tools > Move. 

3) Now take a corner point of the selected geometry of the ground plane and start to move the selected 
geometry. Now type [0, 0, 0] in the Measurement Toolbar which causes the selected point can move to the 
origin point. 

• The clipping generally comes after a DWG import and happened with a combination of the points and while 
moving and checking the scale, following some proper steps all the geometry can be seen in the model. The 
three steps are: 

1) All the layers in the Window menu need to turn on, to do this, click on the Window > Layers menu. 
2) Geometry should be unhidden by using the Edit > Unhide all command. 
3) Now again hide the geometry by clicking on View > Hidden Geometry. 
NOW CLICK ON Camera > Zoom extents for making geometry visible and the full extents of the model also be 
seen. 

All these fixing problems are described in SketchUp through detailed video. 

https://youtu.be/XnazjJ19bQo 

Article Source: blog.sketchup.com 
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How to Set Up Templates in SketchUp 

Simul Chowdhury: Editor 

Templates in SketchUp are the place where you are drawing on. Each template defines the type of your project. 
Depending on the applications, SketchUp comes up with an array of templates. The most common 
concentrated fields for SketchUp templates are – architecture, construction, urban planning, landscape 
architecture, woodworking, 3D printing, and more. 

Templates generally define unite of measurement of your model. Each template has a specific default unit that 
helps you create a design easily with maintaining the accuracy. For example, if you are doing a woodwork 
project, then the unit should be in millimeters and inches because accuracy is a must-to-have thing in this case. 
For creating a building model, inches and millimeters will definitely irritate you. Each model needs a different 
unit to measure the model, and right templates make your job easier for you. 

There is another option called custom template that allows you to add your preferences to the template. 
Sometimes the default ones seem not enough as per your requirement. In this case, you can customize the 
details to make it fit for your model. The list below contains the things you can add or modify in custom setting. 

• The model Info Dialog Box: 
The model info dialog box gives you information about a model. You can change the needed fields as a default 
for your model. 
• Save Geometry for your template: when you save geometry to a template, then the models based on the 
same template will also add the geometry. It works as a default. 
• Styles: you can work with an array of styles in SketchUp. The Style browser has as many types as you want. 
The common options include edit edge, face, background and watermark. 
• Shadows: Shadows give your design a complete touch. Maintaining the right shadow behavior is a necessary 
thing. The option is not default, though. You have to turn on shadow separately as the feature consumes much 
computer processing resulting in a slow performance. 

Change Default Template: When you get started with SketchUp, the first thing that the application asks you to 
do is selecting a template. This default template can be changed further. For this, follow the steps below: 

• Window > Preference for Microsoft Windows and Sketchup > Preferences for MACOS X. 
• Select the Template option from the sidebar. 
• Choose a template from the drawing templates box and then click OK. 

Create a Template: Creating template will help you start your work without giving time in changing the default 
option of templates. If a set of changes has always been used, then save it as a default. This option proves 
more beneficial than you could ever imagine. Follow the steps to do this. 

• Start a new SketchUp file with your present template. 
• Add all essential modifications such as style and shadow to your SketchUp. 
• Select File > Save option. 
• Save your template adding a name 
• Click the Save option 

The Model Info Dialog Box: The content below presents a short knowledge about a Model Info Dialog Box that 
helps you create your model with all necessary details. Different types of settings are categorized in the dialog 
box. Check the list below: 

• Animation: to animate your scene, you can set transition time between scenes. 
• Classifications: this feature will work on the classification data and BIM. 
• Components: you will learn how to add changes in a set of components in your model. 
• Credits: credits let you know the owner of the model or components. You can also Claim Credit to add the 
license holder’s name to the model. 
• Dimensions: you can add text to the model. Follow help.sketchup.com 
• File: this represents the details of a file. 
• Geo-location: you can make your model geo-located by adding location through Google. 
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Besides the above-mentioned options, you can also get features like rendering, statistics, texts, and units. The 
Model Info Dialog Box has come up with the options that you want to have to create your design more 
smoothly. 

The content describes steps and information associated with the SketchUp Template. You have to have 
detailed knowledge regarding this particular tool since it forms the base of your design. 

Article Source: help.sketchup.com 
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Client Communication: the key to better projects 

Subhra Bera: Editor  

Delivering SketchUp models to the clients through right communication is important for projects and Nick shows 
in his video. Communication doesn’t stand only about speaking to and hearing from people, but more than that 
it is about understanding the total message. A good communication depends on many things like the language 
will use, delivering message with the tone of respect, the feeling and the body language at the time of talking. 
These all play important roles in every communication process and can also deliver a confused and wrong 
message if they used in a wrong way. 

In every organization, project manager has the main role of communicating with others such as clients, co-
workers, advisors, dealers etc and also responsible to present the right message to the right person at the right 
time. 

Communication is a symbol of the “transfer of information form one individual to another”. It is seen that the 
failure reason of the projects basically is the miscommunication, most of the project deliverers fail to clearly 
understand the vision and the project’s success criteria. This vision should be strongly communicated to each 
shareholder and team member and the whole team must be able to understand the total result for working 
together for a common goal. 

A poor communication can certainly damage any project or relationship and break down the strength of the 
project. For a good communication one has to be knowledgeable about every detailed and updated thing about 
a project so that he could deliver the right information to the clients or shareholders. 

It is not that this problem happens only in some cases or happens in certain time; it has become a regular 
problem and harming the growth of the projects. A right communication to all the shareholders in a clear and 
actual manner is the capital thing as it clears about the kind of the delivered messages. 

When you are in the field of architecture or design, communication plays the most vital part in every project and 
through 3D communication tools it has become easier to communicate with various people over a project at a 
time. A rich communication with full of right knowledge and information makes a project more successful and in 
SktechUp it is also important. 

SktechUp is not only a tool for modeling and designing it also known for its sharing capacity in 3D. Often 
designers make models and show the idea through the 3D communication system to their clients or other 
teammates as a presentation or for opinion. A good representation of the works of models, their designing, 
capacity and way of working will become the reasons of success and the bad one cause failure. 

To improve the communication way Nick Sonder, a member of SketchUp team has guided everyone with his 
wonderful SketchUp models and LayOut documents. Nick himself is a brilliant commuter and makes a good 
communication with the clients throughout the whole process and with the help of his friend, Houzz he had 
organized design ideas and collaborated with others. He has some brilliant concepts and produced a video 
tutorial as guide for all. 

https://youtu.be/HA9Ls36ohgU 

Article Source: blog.sketchup.com 
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How to Select a Part of a Model in SketchUp 

Simul Chowdhury: Editor 

3D modeling on SketchUp involves easy steps to help you draw a perfect model. The tools and extensions save 
your time and keep the designing process smart and simple. SketchUp, like other 3D design applications, follow 
the common processes at the initial level of your design. ‘Selection’ is one of the basics and most necessary 
features designers should be well-acquainted with. The content brings to you different applications of the 
‘selection’ tool for designing a perfect model. 

To move anything in your SketchUp model, you have to select that object first. Through selecting the model, 
you inform the SketchUp that you are working on that portion of your design. You can rotate, copy, move or 
anything want after selecting the model. 

Things you need to know for using the ‘selecting’ tool: 

Selecting entity in your SketchUp: You must know that every single thing of your SketchUp model is an entity 
that is also categorized in a few names as per their appearance. Elements, objects and annotation are the three 
basic parts of the selection. 

Elements are similar to edges and faces in a design and they together make an object. An object should 
contain a separate name and meta data that defines it. Annotations are texts, guides and selection planes. The 
remaining things other than elements and objects are called annotation. 

Selecting a thing (lines or faces) is not easier, though. Experts have also taken time to know how to select only 
edges in SketchUp. If you, too, are wondering how to do this, go to the wire frame mode and select the object 
by dragging. Since only edges will appear in wire frame mode, it will be easier for you to select an edge. 

Click to select things you want: The easiest way to select an object is to click on that particular thing while you 
are using the select tool. To select more than one object, you need to hold the shift key and click the objects 
you want. Knowing the usage of shift key in selection will help you learn further about SketchUp. You can add 
and subtract both with the shift key. 

The entities look differently as per their character: After selecting an edge, a face or an object, you find a few 
changes in its appearances. Selected edges transform into blue, selected faces covered with blue dots, and 
selected groups and components are surrounded by a blue box – these changes are visible by designers. 

Double or triple click for the selection: Double click or triple click can be termed as the SketchUp select tool 
shortcuts. Double clicking an edge allows you to select edges and adjacent faces both. Through this, you can 
also select connected lines in SketchUp very well. Triple clicking an edge or a face selects the entire model. 

Select many at once in SketchUp: When you need to select many things in your SketchUp design, Selection 
boxes will help you. Such selection is two types – window selection and crossing selection. Window selection is 
called when you click and drag from left to right. This way, you can select things inside your selection box. 
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Cross selection is when you click and drag right to left. It selects anything that touches your selection box. 

Knowing properly the application of selection tool will resolve complicated problems like how to select edges 
and more. The basic of the selection tool is to move an object in your model. 

Article Source: www.dummies.com 
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Preparing for printing from 3D Warehouse to 3D Printer 

Subhra Bera: Editor 

SketchUp is a free 3D drawing program for the architects and designers which are used to easily create 
printable models yet the models need to address before printed from the 3D printer. The models which are 
need to download sometimes found that they are not solid create big problem in the printing time. 

Aaron has come with a solution; he needed a printable scaled version of the US Capitol Building and to record 
the technique of transforming the unprintable into a solid one. 

Basic demands for 3D Printing: 

• Water-tight Model • No paper-thin surfaces • Minimum wall thicknesses and feature sizes • Outward-facing 
surfaces 

1. Water-tight Models: The models which are needed to turn into solid should be fully enclosed as like creating 
an interior space where water could be hold without overflowing it. All the nearby lines and vertices of every 
model need to be in one point not the close enough but should be perfectly in one line. To fix or stray the model 
either the stray vertex could move to the main vertex or the gaps could be filled by drawing new lines. 

2. No paper-Thin surfaces: In case of drawing the artistic models, paper-thin features create problem as they 
prevent in printing as there is not a significant amount of material there. In this case to fix the model one could 
extrude the surface to make it a little thick or can delete it simply. 

3. Minimum wall thicknesses and feature sizes: Every 3D printing system has a certain requirement in case of 
thickness of wall and feature sizes. These features give assurance about printing the model correctly which will 
not break quickly. By deleting the model or extruding the surface a little bit this probl3em can be solved. 

4. Outward-facing surfaces: Often having surfaces in a model face a wrong direction and printing software ask 
for a side of each surface for printing. This can be fixed by right-clicking on the bad face and selecting Reverse 
Faces. Reverse faces will be found by following steps, open the Styles window, click on the Edit tab, click on 
the Face Settings box and then the Back Color has to change into a bright color. 

Convert to STL Format: After doing all the things that are described above, most 3D Printers ask models to 
convert into the STL file format. There are many ways to covert SketchUp file into an STL file and the best free 
converters for using is the SketchUp to DXF or STL Plugin. At first deselect the model, then click on tools > 
Export to DXF or CAD > Export Unit into Inches > Export To in STL. 

Check for STL Errors: After converting it become ready for checking errors but sometime it will make some 
errors so checkout online for fixing the STL errors. 

Aaron Dietzen, SketchUp’s sales manager tried to print his SketchUp file through 3D printing. He has needed a 
printable scaled version of the US Capitol Building and he made a recording of the process of transforming the 
unprintable into a solid model. The original model had a great look so Aaron kept all his focus in the 3D printing. 
Throughout the model, many things could be found such as single surfaces, nested components and each and 
every thing t print. 

The converted model might be like a baffling task to get all of geometry it need to clean up and then turned into 
a solid ready-to-print thing. It should be done carefully as the process can be defined into a series of simple 
steps. 

There is a tutorial video on YouTube as a help. For more follow blog.sketchup.com 

https://youtu.be/GsaatBUg4eQ 
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Use Tables for Managing Spreadsheet in LayOut 

Simul Chowdhury: Editor 

SketchUp offers simple designing tools and features so that anyone can design 3D models effortlessly. The 
functions are designed in such a way that designers give stress more on designs than on the technical parts of 
the applications. This leads a designer to a flawless design that not only communicates well but also expresses 
each part of the model transparently. The feature of using tables for managing spreadsheet in SketchUp is an 
amazing tool that allows designers to maintain data in a well-maintained format. Using table also maintains a 
simple format that does not involve in confusing work to index the data. 

Gone are the days when tables only served the functional purpose. Today’s application developers understand 
the need for offering data booth elaborately and soothingly. This is why the new table format incorporates 
features that make the design appealing and comprehensive. 

Inserting data in the table manually is not a tough task. But, this new LayOut tables can be connected to source 
file easily. It works as other spreadsheets and offers easy-to-use ways to manage the data in the table. 

Insert the formatted spreadsheet: SketchUp tutorials are great to make you understand that how this table tool 
works to manage the designing data. At the time of inserting XLSX files into the table, you will get an option 
staying – retain your formatting. You can easily manage the spreadsheet data along with updating the table 
reference. For formatting – right-click > update table reference. 

Additional formatting: Shape Style Panel comes up with the additional formatting segment. As the name says, it 
works on the shape and style of the table. You can change the style of the table as the data of spreadsheet 
changes. You can uncheck the formatting, though. 

Change the style of the raw data with Scrapbooked tables: Custom scrapbooks are another option that cuts 
down your time and allows you to reuse a format suitable for denoting the data in the table more efficiently. 

To know more details about the SketchUp Tables, visit the official blog of SketchUp at blog.sketchup.com 

Tables in SketchUp combine the good features of spreadsheet application (Excel and Google) and the best 
option of table editors (Word and Google Docs). Besides these two inspirations, the application also adds its 
unique features – unique style and composition of LayOut – to make the table tool more useful for the 
designers. 

 

Article Source: blog.sketchup.com 
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Unwrapping and Unfolding in SketchUp 

Simul Chowdhury: Editor 

In designing, unfolding is definitely a critical process that must be done attentively. Every edge should match 
with the design you are unfolding; else, you will never get the desired result. No matter whether you are 
unfolding on a paper or a metal sheet, you have to follow certain tactics to make this job done creatively. 

With SketchUp, you will get the easiest and the best option to unwrap any design of your choice. The Unwrap 
and Flatten faces Extension is solely designed to provide you with innumerable options to do your job as an 
expert designer. While the basic steps remain same for both digital users and practical experts, other methods 
are completely different from each other. You need to unfold the shapes and keep them flat for cutting. The tool 
for the SketchUp user sometimes unfolds shapes automatically. The content discusses how to unwrap complex 
objects on SketchUp. 

Face Orientation: 

SketchUp has two different face sides – front and back. The front portion is universally colored in white. The 
unfolding process has been done by folding one face that correctly aligned with the face of the other site. It 
depends on the face orientation matter. For getting an accurate result, all faces should be aligned matching with 
each other. If the design contains different face orientations, then the unfolding process needs complex steps to 
go through. Proper analyzing, in this respect, is an important thing to get the best result. Matching the front 
orientation is important in this case. With SketchUp tool, you can different face orientation with the ‘reserve 
face’ option. 

Developable Surfaces: 

Unfolding for developable shapes is not an easy task as designers need to deal with the completed surfaces to 
flat the shape first. In a knowing term, objects with flat surfaces give you the freedom to unfold the design. The 
double-curved objects are hard to unwrap in SketchUp, and this case, a special attention must be taken. The 
designing suggestion tells you that always choose the part of complex objects which cannot be unfolded in a 
regular way. Separate that part from the rest and unfold it in a general way. 

Double curved spaces and material stretch: 

Designers find a great amount of difficulty to complete unfolding project of double curved objects and material 
stretched objects. Generally, double-curved objects are unwrapped in stripes. Those stripes are unfolded 
following specific rules and regulations. But if the object you are working on is made of stretchable materials, 
you need to adopt a different procedure to get your job done. 

Material thickness: 

The thickness of the material also comes in between unfolding an object in the SketchUp. The flat cut out 
portion must match with each other in terms of thickness and sizes when they are joined. The flattened shapes 
do not require much attention to be joined as they match perfectly if the cut is accurate. 

mailto:simul@jobs2india.com�


 

30 | P a g e  
 

 

TABS: 

Many a time, designers are asked to create overlapped edges for glue tabs. In this case, you need to overcut 
the flattened shapes. The Flattery extension will be helpful in to get your result as you expect. 

There are few things that will help you to unfold and unwrap an object on SketchUp. The topic includes many 
sub parts and discussing them in one document would not be possible for any one. So I am mentioning a few 
links that will give an in-depth idea about unfolding objects. 

Article Source: extensions.sketchup.com 
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How to Configure SketchUp for Your Design 

Simul Chowdhury: Editor 

SketchUp stays at the top place when it comes to the 3D modeling applications. Smartly and easily, SketchUp 
performs the tasks that need less knowledge and more imagination. But, complex 3D models are always hard 
to understand, and simplifying which needs your proficient skills. SketchUp also runs slow when it deals with a 
large model containing complex structures. The content discloses tricks and tips that help you sketch big 
designs easily in the software application. It has a certain set of rules that the designers must follow while 
designing. These rules are not mandatory though. They are the answer to how to use SketchUp in the best 
way. This SketchUp tutorial includes a series of good habits that play an important role while designing a 
complex structure. 

Configure your template: 

Configuring a template is necessary that cuts down the time taken for designing complex things. It is always an 
advisable option to create your own template that contains all configured things for your use. To save the 
template, go to the File option and choose Save As. Add relevant information such as name and description of 
the template and click the Save button. 

The saving process will differ as per the version and the operating system you use. 

https://youtu.be/fH8spf1QMzo 

Choose your Unit: Things will go easier if you follow units of measurement for your designs. This allows you to 
use the models from SketchUp Warehouse without rescaling the object. It is the best option and sounds 
effective when you are using Warehouse for your model. 

Steps to follow: 
Window menu> Model Info> Units 

Create layers: 
The most-used layers must be saved for the future use as it gives you an instant access to the configuration of 
your need. With this, you can ignore the recreating of the same layer which is definitely time-consuming. 

Window > Layers (click on the plus icon to add a new layer) 

Delete unnecessary elements from your file: 
Erasing unnecessary elements is an unspoken rule of any designing application. For SketchUp, you need to 
erase the default model and elements from the template before starting your work. you can also delete the 
default figure from the original template. 

To automatically delete the unneeded details, click the Detail icon in layers, components, material and style and 
choose the purge option. 

Keyboard short-cut for the most-used tool: 
Knowing keyboard short-cut will help you increase your productivity while cutting down the time taken for your 
design. Remember the keyboard short-cut of the most-used tool that provides you with an easy access to the 
feature you are going to use, eliminating the need for clicks. 

Other things that need to configure: 
Configuring the needed application as per your preference will help you complete the work without repeating 
the same thing you have done before. This will be a needed step for designing a large and complex model. 
besides the above-mentioned tools, a few applications are still there that need to be configured. 
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• Scenes 
• Rendering style 
• Face and edge 
• Font size used for text levels 

The content is prepared from a popular book - Google SketchUp Workshop by Laurent Brixius. 

  



 

33 | P a g e  
 

Design building: Leers Weinzapfel Associates 

Subhra Bera: Editor 

Leers Weinzapfel Associations is mainly a Boston-based award winning method which has specialized in 
architecture, urban and framework projects. They had worked on a tri-faculty building with an inventive timber 
structure for the University of Massachusetts. The principal of the associates, Tom Chung had given an 
interview to SketchUp team and this article is about that interview where reader can find a new method of 
designing for designers, effectiveness of association helped the project team for making a fascinating and 
continuous project. 

About the project: The team got a project where they had to design a new home for three agencies which were 
connected with the design of the building environment that was spread across the University of Massachusetts 
Amherst campus. In the campus, the department of Architecture, department of Landscape Architecture & 
Regional Planning and the department of Building Construction had to bring together so that they could have 
the same type of teamwork, association and advance in their disciplines. The total building had to be smart and 
continuous and the boundaries should be pushed of geographical, construction and landscape design in a 
single budget as the project was state funded. 

Problems in the project: The team also concerned about the previous street contexts and captured the basic 
views around the campus; they had expanded their site between two streets with various characters. Among 
the twp streets, first one was faced with the larger sized buildings of the campus and the second one had 
smaller structures located the historic part of the campus. 

They tested many locations, forms and design ways in SketchUp and their Landscape Architect, Stephen 
Stimson Associates suggested that both the street could be conditioned with a coherent courtyard bundled in 
between. Both the streets had became a common focal point in the project as it had created a common space 
for the citizens and visitors of the building which was started from the landscape garden on the third floor and 
ends up on the ground floor to welcome the least of the campus. 

They made this ‘commons’ space in an animated way with a dynamic 3D truss which was made with Glulam 
beams and metal tension rods. It was basically made as a support for the roof garden that had up to 18’ of soil 
and dense planting. 

Reason of selecting timber in this project: Alexander Schreyer, chair of Building and Construction was the main 
enthusiast for using the timber structure in the project of the client. Alex had knowledge and interest on this 
matter and gave the team confidence for using timber in the project. They took help form some specialist timber 
structure engineers, Equilibrium Consulting and as a result they had arrived as the first group timber structure of 
its size and scale in the United States. In this timber made structure, the structural body was of glulam beams, 
the columns and the floor deck was the unique combination of Cross-Laminated Timber or CLT and concrete. 
The complex floor was combined of wood and concrete for creating delegate long spans which were stable, 
serviceable and wonderful for controlling vibration and auditory. 

SketchUp in design process: According to the Leers Weinzapfel Associations, SketchUp is a very useful tool for 
them and could easily model things for having the skill and energetically works on projects. They had tested 
various absorptions and conceptions which vary on the location form the Google 3D map and plug in their 
design for the contextual fit. The walk-through feature also helped them to capture and demonstrate the quality 
of the main spaces. For changing the design they transferred it into the construction documents created in 
Revit. They also had focused on specific conditions in SketchUp before centralizing it into the final drawings 
and this method was become helpful for further long term deign processes. 

Project’s point of continuity: A timber structure defined that it is a sustainably harvested renewable material with 
very low illustrated energy and carbon. The instant nature of the timber structure also decreases on-site labor 
demanding processes and accelerates the building process. Choosing the timber structures instead of steel and 
concrete also could leave a big impact on global carbon emissions and can make the world healthier. Besides 
the specification on the material, they also had a limited budget that prevented them from using costly bolt-on 
renewable strategies at the end of the work. But it is also true that the building consumed less energy from the 
beginning and they used a LEED Platinum rating and renewable energy sources due to their cost boundary in 
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the project, so they used campus’ existing chiller system that was very helpful. They also planned spaces for 
fitting the mechanical heating and cooling services. 

Role of collaboration in the project: In this low-budget project, collaboration played an important part which was 
very much necessary for the success of this project and the collaboration could be seen everywhere. The 
collaboration between the team and the clients showed by the three different UMass department heads, they 
also used their imagination in various way into the dimensional planning of the building ensured the chance 
encounters between the students and faculty in the departments increased. The sustainability consultant, 
Atelier Ten, MEP engineer, BVH Integrated Services were there with the team from the beginning and by 
handling massing, orientation and façade design they made an energy efficient building. Though their method 
was not familiar in the Boston Area of the United States they tried their best to make the project successful and 
they did it. 

Article Source: blog.sketchup.com 
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CleanUp3 and Solid Inspector2 in SketchUp 

Simul Chowdhury: Editor 

Introduced by Thomas Thomassen, both tools are important to erase the errors of your design. While CleanUp 
tools delete the unnecessary components and reduce the size of your design smartly, Solid Inspector checks 
the problems existed in your solid models. These tools are also useful to make your SketchUp design 3D print-
ready. They easily erase the problems of your design without the intervention of your calculation and 
measurements. The content describes these tools in a brief way. 

CleanUp3: The tool works best in reducing the heavy size of your SketchUp design in a logical way without 
making any visible change. Unnecessary and hidden elements generally put loads on the size of the model. 
The feature finds out these objects and cleans up smartly. 

To open the tool: 

Plugins > CleanUp 

The benefits of using this extension: 

• Eliminates unused items 
• Deletes hidden geometry and duplicate faces 
• Remove lonely edges and edge materials 
• Merge identical materials 

This extension is particularly being used for 3D printing for your SketchUp model. if your design contains an 
array of models and shapes, this tool deletes the hidden elements brilliantly to make the download of your 
model easier. 

Solid Inspector2

To know how it performs, click 

: Solid Inspector goes by its name and detects the problem areas of a group or a component 
that prohibit them being the solid manifold. This extension needs SketchUp 2014 or the newer version to run 
smoothly. 

Application: Click the group or components to find out the holes and click fix button to solve the issues in a 
hassle-free way. 

To Open the Extension: 

Toolbar> Solid Inspector2 

These tools perform well when it comes to detecting the underlying problems of your 3D design in SketchUp. 
They create an effortless platform for you where you can delete unnecessary objects to improve the style of 
your design. 

extensions.sketchup.com 

https://youtu.be/wkj5RQn17Vs 

mailto:simul@jobs2india.com�
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A brighter future for one SketchUp classroom in Brazil 

Subhra Bera: Editor 

Previously in some areas of Campinas, Brazil, it was hard to find the experienced in software and technology 
but two Trimble colleagues in Brazil, Isabella Glacomin and Lais Tatagiba took an initiative to change this 
scenario. They launched a youth eclipse program that brings undeserved students with disclosure to SketchUp 
and also promoting a brighter future in this disadvantaged part of the country. 

About the Youth Outreach Program: Trimble team in Brazil always took initiatives and activities for serving the 
community and giving it back some helping hands for better work. This year they thought to launch a youth 
outreach program with SketchUp and began their partnership with CEPROMM. CEPROMM is mainly a non-
profitable association which helps and supports children, teenagers and women who live in an underserved 
area of Campinas known as Itatinga. 

Campinas is located about 60 miles away from São Paulo and the area of Itatinga is known in Latin America for 
its uncontrolled usage of heavy drugs and have high prostitution rates. CEPROMM was founded in 1993 and 
dedicated to provide important resources to the underprivileged children and teens that are facing harmful 
situations at home. This association is currently aiding about 270 children, teenagers and their families by 
educational, personal and professional development programs and also organizes different mental health 
programs, arts and computer classes, sports and many more to enhance the good living skills in them. Trimble 
has connected with them for giving them some more different thing to live well in life. 

Works around 3D modeling: Trimble with CEPROMM is going to the outreach project with SketchUp from 
Project Spectrum which will help the youth on the autism development in vocational skills and if this succeeds 
then a similar program will be held in Brazil also. The work has begun and CEPROMM is giving the students 
the access to coursework like computer classes that is not common in the traditional schools. The vocational 
tests given to the students help them to discover and operate possible career paths and it is hoped that it will be 
helpful for them. With this computer classes Trimble is willing to give the basic SketchUp lessons to make a way 
of working in 3D modeling or design in future. 

The curriculum of the project: The program of giving the students a basic knowledge in SktechUp will help the 
students to become a basic or beginner user of SketchUp. The program is divided into three, two-hour long 
courses where they could take lessons step by step. In the first class, the students were given the knowledge of 
the basic tools and commands in SketchUp, then they learnt to draw simple lines, shapes there, work on 
changing the scale, moving the objects, also learnt to create groups and editing them properly. 

In the second class, they created a 3D model using a 2D project and also learnt the process of creating 
windows and doors, it was a fun experience for them where they draw their imagination and gave them a 
beautiful shape. In the last class the learnt to create materials, textures on the walls and floors of their model 
house and also the method of importing the furniture from 3D Warehouse and customizing the things properly. 

Ways of adding exposure to SketchUp: The students found a new world in SketchUp as they were never 
experienced this kind of technologies before in their school and at first they found some difficulty for them to 
grasp. Trimble helped them to grow their abilities of achieving something in future. 

Creative models of Students: They have used their imagination and hidden wishes and created different models 
like house, swimming pool or garden etc. 

Skills they learn: Though the students were taking SketchUp more excitingly and tried to create the models in a 
fast way but they soon understand that slowing down the work process will make the models better. Then they 
leant the things with ease and patience and put them in the models, this patience and eager to grab the 
knowledge will lead them to their beautiful future knowledge. 

The future plans of the program: Both Trimble and CEPROMM ahs started to develop an action plan and 
decided some future plans for taking this program a new level. So they are willing to continue the lessons of 
SketchUp with the students and trying to give them the ability of mentoring other students under them so that 
the learning process can go further. 
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Article Source: blog.sketchup.com 
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Magazine Details – The Creative team of Sketchup-ur-Space 

Started in September 2010, Sketchup ur Space (SuS) was the first online magazine devoted to SketchUp, that 
unique, innovative 3D design tool from Google. It holistically covers features, events, news, updates, reviews 
and many tips and tricks. 
 

 

Simul Chowdhury: simul@jobs2india.com 

Simul, the editor of SketchUp ur Space magazine is the main writer. He is responsible to 
write the cover story, blog and many other columns. Along with it, He is creating a 
liaison between the writers and the readers. 

 

 

Subhra Bera: subhra@jobs2india.com 

Subhra, the editor of SketchUp ur Space magazine is the main writer. He is responsible 
to write the cover story, blog and many other columns. Along with it, He is creating a 
liaison between the writers and the readers. 

 

 

Manoj Kumar Singh: manoj@jobs2india.com 

Manoj is enthusiastic helps to put the content of the SketchUp up Space magazine in 
the html version. Manoj is the html developer who beautifully creates each and every 
edition with care along with the PDF version. 

 

 

Pritish Pattanayak: pritish@jobs2india.com 

Pritish is the designer-in-chief of this magazine with the help of his creativity Sketchup 
ur Space has gotten a classy as well as trendy look... 
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